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Cóm recuperar les teves dades

How to retrieve your data (in English) | Other languages using Google Translate

Les dades que hagis adquirit en qualsevol dels espectròmetres del Servei de RMN estan disponibles
en tot moment i des de qualsevol lloc a través del nostre servidor de dades. Per recuperar-les, hauràs
de descarregar-te i instal·lar el programa FileZilla, i configurar-lo perquè es connecti al nostre servidor
de forma segura.

Per tal de preservar la privacitat de les dades de recerca dels grups, cada grup de recerca i empresa
té un compte virtual d'ús exclusiu, amb el qual accedeix només a les seves carpetes de dades als
espectròmetres i ordinadors del SeRMN.

El servidor de dades fa servir el programa ProFTPD per gestionar la connexió i transferència segura de
dades a través del protocol  FTPS/FTPES. Aquest protocol de transferència de dades utilitza  TLS
per encriptar les comunicacions entre el client i el servidor, el mateix protocol d'encriptació que fan
servir els navegadors per accedir a servidors web segurs via HTTPS.

Per accedir al servidor de dades necessites un  client de FTP que permeti connexions encriptades
amb TLS. Nosaltres et recomanem el programa FileZilla tot i que pots fer servir d'altres que siguin
compatibles amb el protocol FTPS/FTPES (FTP over TLS).

Les carpetes al servidor de dades

Quan et connectis, veuràs diverses carpetes que enllacen directament amb les carpetes de dades
dels espectròmetres actualment disponibles i també dels antics espectròmetres. El nom de la carpeta
indica a quin espectròmetre correspon.

Espectròmetres actuals

Aquestes carpetes corresponent als espectròmetres actualment instal·lats al servei:

Nom de la carpeta Espectròmetres actuals

av-dpx-250-auto Espectròmetre Avance DPX 250 MHz, amb bescanviador de mostres per cua de
rutina.

av-neo-300 Espectròmetre Avance Neo 300 MHz per autoservei.
av3-400-sb Espectròmetre AvanceIII 400 MHz, amb accessori HR-MAS.
av-neo-400 Espectròmetre Avance Neo 400 MHz per autoservei.
av-neo-500 Espectròmetre Avance Neo 500 MHz, amb criosonda.
av3-600 Espectròmetre AvanceII+ 600 MHz, amb bescanviador de mostres.
biospec-7T Espectròmetre BioSpec 70/30USR amb imant horitzontal.

Espectròmetres disponibles anteriorment

Aquestes carpetes corresponen a espectròmetres anteriorment instal·lats al servei i que actualment

https://sermn.uab.cat/wiki/doku.php?id=howto_retrieve_your_data
https://sermn-uab-cat.translate.goog/wiki/doku.php?id=howto_retrieve_your_data&_x_tr_sl=auto&_x_tr_tl=es
http://filezilla-project.org/
http://www.proftpd.org/
https://en.wikipedia.org/wiki/FTPS
https://en.wikipedia.org/wiki/Transport_Layer_Security
https://en.wikipedia.org/wiki/FTPS
https://en.wikipedia.org/wiki/Transport_Layer_Security
https://en.wikipedia.org/wiki/Comparison_of_FTP_client_software
https://en.wikipedia.org/wiki/Comparison_of_FTP_client_software
http://filezilla-project.org/


Last update: 2024/02/07 15:00 informacio_recuperar_dades https://sermn.uab.cat/wiki/doku.php?id=informacio_recuperar_dades

https://sermn.uab.cat/wiki/ Printed on 2025/09/19 09:32

ja no existeixen:

Nom de la carpeta Espectròmetres anteriors

av-dpx-250-robot Espectròmetre Avance DPX-250 MHz, amb bescanviador de mostres per cua de
rutina.

av-dpx-360 Espectròmetre Avance DPX-360 MHz per autoservei.
av2-400-wb Espectròmetre AvanceII 400 MHz, imant wide-bore, amb accessori CP/MAS.
av-drx-500 Espectròmetre Avance DRX-500 MHz, amb criosonda i LC-DAD-(SPE)-NMR/MS.

Segurament mai veuràs tots aquests instruments, ja que cada grup només veu els espectròmetres a
què té accés, com a mínim, un membre del grup.

Cada grup de recerca i empresa només té accés a les seves carpetes de dades.

Així doncs, quan adquireixis espectres, comprova que guardes les dades a la
carpeta del teu grup. Si les guardes en la carpeta equivocada, no podràs recuperar-les
a través del servidor de dades.

Fes servir només lletres sense accents, números i guions (alts i baixos) per als
noms dels experiments,

És molt recomanable que només utilitzis

lletres minúscules i majúscules sense accents: a-z A-Z
números: 0-9
guions: - _

per als noms dels experiments, ja que la resta de caràcters (accents, asterisc, cometes,
parèntesis, etc.) podrien causar problemes a l'hora de recuperar les dades per xarxa.

Obre el firewall del teu institut o empresa

El client i el servidor de FTPS/FTPES es comuniquen a través dels ports 990 (FTPS) i 60000-65534
(IANA Ephemeral ports, de forma que hauràs d'assegurar-te que no estan bloquejats per cap tallafocs
(*firewall*).

A mitjans de 2022 vàrem canviar el número de port del servidor FTPS de 21 a
990 per tal de fer servir el número de port oficial per aquest protocol:

Port 990 Details
Service: ftps
Details: FTPS Protocol, FTP over TLS/SSL (IANA official) uses ports 989 and 990.
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https://www.speedguide.net/port.php?port=990

Si accedeixes al nostre servidor des de dins de la UAB, o des d'un institut de recerca o empresa al
campus que tingui la seva xarxa integrada a la xarxa de la UAB, no hauries de tenir problemes per
connectar-te i descarregar-te les teves dades.

Per contra, si et connectes des d'un ordinador de fora del campus, i el teu institut o empresa disposa
d'un firewall per protegir-se, hauràs de demanar als responsables del firewall que el configurin per tal
que puguis recuperar les teves dades.

La configuració és molt senzilla i no comporta un risc de seguretat inassumible, es tracta de:

obrir el port 990 (FTPS) pel protocol TCP de sortida; i
obrir el rang de ports 60000-65534 (IANA Ephemeral ports for FTPS) pel protocol TCP
d'entrada cap als ordinadors de la teva xarxa

per tal que et puguis connectar al nostre servidor FTPS-TLS via FTPS-Passive des de dins del
firewall.

Si volen restringir els ports oberts només per la nostra adreça IP, diga'ls que és la IP:
158.109.58.175 amb hostname: sermn.uab.cat

No et preocupis si no entens res del que posa aquí amunt, és informació tècnica pels administradors
del teu firewall.

Accedeix a les dades amb el FileZilla

 El programa que et recomanem per
accedir al servidor de dades és el
FileZilla, un client de FTP amb interfície
gràfica, disponible per Windows, Mac OS
X i Linux.

En el moment de redactar aquestes instruccions, la versió més actual és la 3.66.4, però com que
surten noves versions força sovint, segurament et trobaràs una versió més nova per descarregar i
instal·lar. Per altra banda, és molt recomanable que facis cas del programa quan t'informi que hi ha
una nova versió i et proposi descarregar-la i instal·lar-la. Fer-ho és un moment, i no requereix tornar a
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configurar-ho.

Instal·lació

A la pàgina web del programa FileZilla trobaràs unes instruccions d'instal·lació completes, detallades i
actuals sobre cóm instal·lar el FileZilla Client a MS-Windows, Mac OS X, i GNU/Linux.

El programa te'l pots descarregar directament del lloc web del FileZilla.

Configuració detallada

Si no estàs familiaritzat amb la configuració del FileZilla segueix aquestes instruccions detallades. En
elles t'expliquem pas a pas cóm configurar el programa per accedir al nostre servidor de dades, a
més, les múltiples captures de pantalla que t'ajudaran a completar amb èxit el procés de
configuració.

En cas contrari, fes servir les instruccions de configuració ràpida del següent apartat.

Configuració ràpida

Si estàs familiaritzat amb el FileZilla fest servir aquestes instruccions breus per configurar-lo:

Anar a Edit → Settings1.
A Transfers → File Types i ajustar la configuració a,1.

Default transfer type: Binary
Desmarcar les opcions Treat files without extension… i Treat dotfiles as…

A Language2.
Triar l'idioma de la interfície

Prémer el botó Ok  per guardar els canvis i sortir de la finestra Settings3.
Anar a File → Site Manager2.

Prémer el botó New Site  per crear un lloc nou. Assigna-li un nom com SeRMN-UAB Data1.
Server.
A la pestanya General entrar els següents valors,2.

Host: sermn.uab.cat
Port: 990
Protocol: FTP - File Transfer Protocol
Encryption: Require explicit FTP over TLS

Defineix el tipus de compte i credencials d'accés,3.
Si aquest és un ordinador d'ús exclusiu pels membres del grup de recerca,
configura'l amb

Logon Type: Normal
User: el username del teu grup (demana'l al teu Cap de grup o algun
membre sènior)
Password: la contrasenya del teu grup (demana-la-hi al teu Cap de
grup o algun membre sènior)

Si aquest és un ordinador compartit amb altres grups o persones, fes
Logon Type: Interactive, i

http://wiki.filezilla-project.org/Client_Installation
http://filezilla-project.org/download.php
https://sermn.uab.cat/wiki/doku.php?id=configuracio_filezilla
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deixa que el FileZilla demani el nom d'usuari i contrasenya cada cop que algú
es vulgui connectar.

Prémer el botó Ok  per guardar la configuració i sortir de la finestra Site Manager.4.

Ara ja pots provar a connectar-te:

Selecciona el lloc SeRMN-UAB Data Server (o com sigui que l'hagis posat) a File → Site Manager1.
Si has configurat el compte com a Logon Type: Normal el programa només et demanarà1.
el password del teu grup.
Si l'has configurat com a Interactive el programa et demanarà el username i password del2.
teu grup.

En tots dos casos prem el botó Ok  per iniciar la connexió.2.
Si encara no has acceptat el certificat del nostre servidor, o si l'hem renovat, el programa et3.
mostrarà les dades del certificat i et preguntarà si l'acceptes. Prem el botó Ok  per acceptar-ho i
continuar amb la connexió.
Si tot ha anat bé, ara ja hauries de veure el llistat d'instruments als quals té accés el teu grup4.
de recerca.

Has de demanar les credencials d'accés al responsable del teu grup de recerca
o empresa.

El SeRMN només proporciona les credencials d'accés (*nom d'usuari* i *contrasenya*) als
responsables de cada grup de recerca o empresa, i la distribució d'aquesta informació
dins el grup de recerca o empresa és responsabilitat seva.

Recorda que cada grup de recerca només té accés a les seves carpetes de dades.
Quan adquireixis espectres, comprova que guardes les dades a la carpeta del teu
grup. Altrament no podràs recuperar-les via xarxa.

Si tens cap problema a l'hora de recuperar les teves dades a través del servidor, posa't
en contacte amb el personal del servei i mirarem de resoldre el problema.

Exemple de sessió per transferir dades

Les imatges següents mostren cóm descarregar-se dades des del servidor de dades. El primer que
hauràs de fer és obrir el Site Manager, seleccionar el compte on has definit la connexió al nostre
servidor de dades, i prémer el botón Connect  per iniciar una sessió,
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Si has configurat correctament els paràmetres de la connexió, i si no hi ha cap problema a la xarxa,
de seguida s'obrirà una pantalla amb el certificat digital que identifica el nostre servidor de dades. Per
connectar-te has d'acceptar-lo prement el botó OK .

El servidor de dades fa servir un certificat oficial de la UAB generat per GEANT
Vereniging que es renova anualment.
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Si no vols haver d'acceptar el certificat cada cop que et connectis, marca l'opció Always
trust certificate in future sessions.

Si el nom d'usuari i la contrasenya d'accés ja estan definits al compte (veure més amunt, Logon type
definit com a Normal) el client procedirà directament a iniciar una sessió. En canvi, si has definit un
compte de tipus interactiu (veure més amunt, Logon type definit com a Interactive), el programa et
demanarà primer el nom d'usuari i després la contrasenya abans d'iniciar una sessió,

En tots dos casos el programa et mostrarà les comandes que executi i el contingut de la carpeta
remota al servidor de dades,
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La figura anterior mostra la pantalla del FileZilla amb la configuració gràfica per defecte,

Al panel 1 es poden veure els missatges bescanviats entre el client i el servidor. En cas de
problemes, aquesta informació pot ajudar a identificar la causa del problema i a resoldre'l.
Al panel 2 es mostra l'arbre de directoris local, i al panel 3 el llistat de fitxers continguts a la
carpeta actualment oberta
De forma semblant, al panel 4 es mostra l'arbre de directoris al servidor de dades, i al panel 5
el llistat de fitxers continguts a la carpeta del servidor actualment oberta.
Finalment, en funció de la pestanya triada, al panel 6 es pot consultar l'estat de la
transferència de fitxers: fitxers en cua, fitxers transferits, i errors a la transferència de fitxers.

La configuració de la interfície gràfica es pot modificar a través del menú View.

Per transferir dades hauràs de triar primer l'espectròmetre o ordinador al qual vols accedir,

dins de la carpeta de cada espectròmetre trobaràs com a mínim una carpeta de nom nmr que conté
les dades més actuals, tot i que també poden haver-hi altres carpetes corresponents a anys anteriors.

Per transferir les dades d'un experiment has de seleccionar la carpeta corresponent

i, amb el botó dret del ratolí, desplegar el menú i triar l'opció Download
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Un cop completada la transferència de fitxers, les carpetes de dades apareixeran al panel
corresponent a la carpeta local del teu ordinador.

Alternativament, pots arrossegar les carpetes seleccionades al panel on es mostra el
directori local, o fins i tot pots arrossegar-les a una finestra de l'explorador de Windows o
a l'escriptori.
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Quan hagis acabat de transferir dades, només cal que tanquis el FileZilla per desconnectar-te del
servidor de dades i finalitzar la sessió.

Per més informació sobre l'ús del FileZilla pots consultar l'ajuda del programa o la documentació
disponible a la seva pàgina web.
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